
User Guide for ADF Returns 
in PICTUS

v4.7  (Feb 15, 2024)

PICTUS is a "self-serve" application that allows you to submit your ADF Returns 
and payment, monitor your account balance, manage your company's contact 

information, and determine who in your company has access to your ADF data. 
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Getting Started – Access
TSBC e-Commerce

A)  General System Requirements:

1. This is a web application, accessible through most common web browsers. 

2. Use the latest version of: Google Chrome, Microsoft Edge, Mozilla Firefox or Safari as your internet browser. (Do NOT use 
Internet Explorer as that browser is not supported through the application).  Note: You may need to refresh your browser or 
use one of the other recommended browsers to be able to access the application.

3. The system link is: https://tsbc.pictus.online Sign-in using the e-mail address that was used to set-up your account, either from 
the “Invite” you received from an existing User, or from the Self-Service Registration process you initiated.  

4. Your e-mail address is your system account “User Name” and once created it cannot be changed.

B) Access to the System:   There are 3 ways to get access to the e-Commerce system:

5. If your business is already registered with TSBC, we have already given you access to the system, so you do NOT need to Re-
register for access.  Use your existing User ID (e-mail address) to log into the system. 

6. If someone from the Agency or from one of your Businesses has “Invited” you to use the new system, you will have received 
an “Invite” e-mail with a link to Reset your Password.  Once you reset your password and log-in, you need to complete your 
Contact information.  Once that is completed, you will be logged into the system.

7. You can request access to the system using the “Self-Registration” process by clicking on “REGISTER” from the Log-in Page.

i. “Create Account”:  Provide your E-mail address (must be unique and not already used in the system).

ii. “Contact Details”:  Provide your First and Last Name and Phone Number.

iii. “Create Organization”:  Provide the name of the Business and add “(Org)” to the end of it. 

iv. Once your account is set-up (which includes your Organization), you will be directed to the main Summary Page.  You 
can then submit your registration information using the “Create Business” function.
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Getting Started – Access
TSBC e-Commerce

C)  Register a New Location:

8. Once you have access to the system, and you want to apply to Register a new location, you must apply online:

a) Complete the online “Self-Registration” process by entering your information and attaching a completed “Terms and 
Conditions” form directly in the system (there is a link to the form from within the system).  

b) Refer to the “Registration” sections in this document. 

Note: You must complete all of the steps at once in order to “Submit” the application. Partial information will not be saved.  

Contact TSBC at 1-866-759-0488 or via e-mail at registrations@tsbc.ca if you require further assistance.

D)  Self-Registration Process - Overview:

9. The quickest way to apply to Register a new location, is to complete the online “Self-Registration” process by entering your 
information online and attaching the completed form directly in the system.  

10. As you complete each step in the online submission process, you will need to provide specific information, so have it handy. 
You must complete all of the steps at once and cannot save partial (“draft”) information.  

11. During the “Create Business” process, you will see a link near the top for the “Terms & Conditions” file.  Click on the link to 
open the fillable form. Download the form, complete and sign it then scan it to your machine, as you will need to attach the 
file as part of the online process.

12. If you already have an account, Login and click on the blue “Create Business” button.

13. If you do NOT yet have an account, click on the “REGISTER” from the Log-in page.  This allows you to first create an Account 
and then you can use the “Create Business” function. Follow the steps listed under the section in this document called “Self-
Registration – Create Account”.
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Getting Started – Access
TSBC e-Commerce

D)  Self-Registration Process – “Create Business”:

14. To Register a new Location (“Create Business”), from the main Summary Page, you need to:

a) Select the Organization that the new Business will be related to.  If you only have 1 Organization, it will be the default for 
your new Business registration. 

b) Click on the blue button labelled “Create Business” then select “Create Remitter”. 

c) There are several steps to submitting your Business for registration.  You will need to provide the following information.  
Each area (“tab”) will have a green check mark once the necessary data has been provided.

i. Business Name (the “Doing Business As” name), Legal Name, Type of Business, Operations Start Date.

ii. Address(es) and any other Contacts.

iii. Create a “Notes & Files” and attach the completed “Terms & Conditions” form (follow the link to open the fillable 
form).

iv. Once all the tabs have green check marks, click on the “Submit” button.  This completes the process and the 
form is sent to TSBC for processing.

15. Once the registration application has ben submitted, the Agency will review your submission and process the application,  
You will be advised of the registration decision and provided additional details on how to file your ADF Returns.

16. Please refer to other sections of the document for screenshots and step-by-step process for submitting a “Self-registration” 
application.
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Getting Started – Access
TSBC e-Commerce

E)  Passwords:

17. Set (or re-set) your Password using the “Forget?” function on the Log-in page.  

18. You will receive an e-mail from  ecofees@tsbc.ca with a link to set (or reset) your password. You may also receive e-mails 
from one or more of our other e-mail addresses, such as:  registrations@tsbc.ca or compliance@tsbc.ca .

19. If you don’t receive an e-mail in your Inbox, check your “Junk” folder in case your system does not recognise the e-mail ID 
(and mis-takes it for junk). 

20. Also, if possible, add the domain of “@tsbc.ca” to your “safe list” so all e-mails from us are accepted by your system.  If you 
are still having issues logging in, please contact TSBC at 1-866-759-0488.

21. Passwords must be at least 10 characters long and contain 1 upper case letter, 1 lower case letter and 1 number.

F)  Once Logged in:

22. You should “bookmark” the e-Commerce log-in page (https://tsbc.pictus.online) for future reference, as you will need to sign 
in each month and File your ADF Return.

23. Once you log-in you can “Change Password” at any time from the Summary page menu (upper right corner).  If you forgot 
your Password, click on the “Forgot?” text on the log-in page.

24. Refer to the “Filing” section of this Guide on how to submit your ADF Returns online.

25. Refer to the “Quick Reference Guide” for a short 2-page reminder on the basic steps to use the system.  The Guides are all 
available from the “Participant Resources” section of the TSBC website: https://tsbc.ca/participant-resources/
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2. Log-in, Home Page & Passwords
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Log-in Page
https://tsbc.pictus.online

• Enter your Email ID and Password (minimum of 10 characters) and click the blue “Login” button.

• To initially Set or to Reset a Password if you have Forgotten your Password, enter your E-mail ID then 
click on “Forgot?” link.  You will receive an e-mail and instructions on how to set your password.

• Refer to the “Self-Registration” sections of the “User Guide” for details on using the “REGISTER” function.

Note:  Below the “Register” function are 2 lines which display your browser type and version (e.g. Firefox 
122.0), and the current version of PICTUS (e.g. App 4.7.1.3). You may need this info if you require support.

.
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Home Page
Login > Home

• The “Home” or landing page is the communication and launching point into other parts of the application.

• This page shows a Summary of your Filings so you can see if any are outstanding or waiting to be paid.

• Notifications may be general (for all users) or could be specifically for you.  
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• To File your ADF Return, click on the blue “View Filings” button.

• To Edit your company information, click on the “Participants” tab at the top (to the right of the “Home” tab).

• Your Email ID are displayed in the upper right corner beside the menu icon.

• To edit your personal Contact information, select  “Profile” from the drop-down menu in the top right-hand corner of screen.



Home – Profile & Change Password
Login > Home

• The “Home” page is the communication and launching point into other parts of the application.

• Your Email ID are displayed in the upper right corner beside the menu icon.

• If you click on the Summary page menu, you can also edit your “Profile” 

• You can “Change Password” also (once you have your initial Password setup). Passwords must be at least 10 characters long and 
contain 1 upper case letter, 1 lower case letter and 1 number.

• Some organizations require employees to change passwords on a regular basis for security purposes.
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3. ADF Returns – Filing: Individual Returns
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Home Page
Login > Home

• The “Home” page shows a summary of your Filings so you can see if any are outstanding or waiting to 
be paid.

• To File your ADF Return, click on the blue “View Filings” button.

• This will take you to another screen where you can select one or more of the outstanding Filings (ADF 
Returns) that you want to complete.
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Filing – Main Page
Login > Filing App

• The “File” function is the core of the system and what you will use mostly. Your outstanding filings 
will be shown in the “File” tab (on far left).

• To complete a filing, click the “File” button to the right of the row.

• Complete 3 easy steps:  File, Approve and Pay!!

NOTE:  You must file a “Nil” Return even if you have paid your wholesaler the ADF Fees.
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Filing an ADF Return
Login > Filing > File

• The blank ADF Return form is shown below. 

• Simply fill in the Quantity of each product sold for that reporting period and click “Save and 
Submit”.

• There is a “Save” button if you aren’t quite ready to Submit. This keeps the filing “In Progress” 
until you go back into the screen, make any changes and then click on “Save and Submit”.
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  • If the remitter sold no tires in the period, check the box next to “Nothing to report this period.” and then “Save and Submit” (a “Nil 

Return”). NOTE:  You must file a “Nil” Return even if you have paid your wholesaler the ADF Fees.

• You can optionally add a “Note” to the Filing if you want to highlight anything related to the Return.  The Note will show on the Invoice, 
so it remains there for future reference.



4. ADF Returns – Filing: Download & Import     
(Multi-Remitter Orgs)
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File – Download & Import
Login > Remitters > File

• The “Download” and “Import” functions are only available if you have 2 or more 
Remitters within an Organization.  (These buttons do NOT appear if you are a single 
Remitter Organization.)
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• If you have more than 1 Remitter, you can click on “Download” to open a pre-formatted Excel spreadsheet (for a single Filing period) 
that lists all of the Remitters within your Organization. Save the file and then populate the volumes of each tire for each location.

• Once the data is all entered and checked, you can “Import” the completed file into the system. That will then populate the ADF 
Returns for each Remitter.



Remitters – File Download
Login > Remitters > File

• If you are a multi-Remitter Organization, you can click on the “Download” button to 
create an Excel spreadsheet with the Remitters listed for a given Filing Period.

• You need to specify which Filing Period and which Filing Type you want to download 
and import.

• You can then complete the ADF details for each Remitter for that period and then 
“Import” the file (to populate the Filing records).
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Remitters – Complete Filing
Login > Remitters > File

• The snapshot below shows an example of a downloaded file for “Joe’s Tire Empire” 
organization and lists each of its 2 Remitter locations.  

• This is for the August 2020 Filing Period, and for Regular Filings only.  You can 
download one file for each period and for each Filing Type (Regular or RIV).

• Note the total at the bottom for cross-checking volumes and payment calculations.

• This also provides the Organization with a record of what they submitted, without 
having to download each invoice.
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Remitters – File Import
Login > Remitters > File

• Once you have completed the Downloaded file, and confirmed that the information is 
correct, you can use the “Import” function to upload the file.

• The “Import” button allows you to select the file from a location on your computer.

• Once you confirm the file, it will upload the data and populate the Filings for each 
Remitter, so you can then “Approve” them.
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5. ADF Returns – Filing: Approve, Adjust & Pay
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Approve Filing(s)
Login > Filing > Approve

• All Submitted filings collect on the “Approve” page (tab).  A user with the “Filing Approver” role can approve or reject one or 
more filings (i.e. can be done as a group for multiple filings). To reject a filing, check the Filing then “Reject Filing” at the bottom.

• Click on the Filing(s) to approve and click next to “I certify…” then click on “Approve”.  This moves the Filing to the “Open 
Invoices” tab.  To Approve all Filings at once, click on the box next to the “Amount” in the upper right side of the Filings list, then 
certify and “Approve”.

• Once Approved, the Filings cannot be changed and become Invoices. The invoices show up on either the “Open Invoices” tab if 
payment is required, or the “Closed Invoices” when payment is not required (e.g. Nil Returns).

• Contact TSBC if a mistake has been made and they will create an Adjustment Filing.
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Click to approve 
All Filings listed.

Click one or more 
Filings to approve 
(including Nil Returns).

OR

Certify then 
Approve or 
Reject the 
selected Filings



Filing – Adjustments & Payment
FAQs

1. Q:  How do I make adjustments to my ADF Return once it has been submitted?
A:  Once an ADF Return has been approved it cannot be adjusted. However, TSBC is able to adjust a Filing (ADF 
Return) if necessary, so please contact them if you require a Filing adjustment.

2.  Q:  How do I setup TSBC as a “Payee” in my online banking system?
A:  To setup TSBC as a bank “Payee” log into your banking system and go to where you setup a new “Payee” 
(usually under “Bill Payments”).  Search on “tire”. They will be listed as “Tire Stewardship BC Association”. 
Enter your 5-digit TSBC Registration # as your Account #.

3.  Q:  What is TSBC’s banking information so I can setup payments to them by EFT?
A:  You will need to contact your bank to ensure your accounts allows EFT transactions.  Then use the following 
payment routing instructions to setup TSBC for EFT Payments:

Bank of MontrealPay:

S.W.I.F.T BIC CODE: BOFMCAM2 Bank ID Codes:

BMO Bank of Montreal 
2219 Oak Bay Avenue 
Victoria, BC    V8R 1G4 

Account with 
Institution: 

Tire Stewardship B.C. Association 
300 – 536 Broughton Street
Victoria, BC    V8W 1C6

Beneficiary 
Customer:

Transit: 27060 
Institution: 001 
Account: 8900-427

Bank Account:
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6. Invoices – Open and Closed
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Invoices – Open (Unpaid)
Login > Filing > Open Invoices

• The “Open Invoices” tab lists invoices that have been approved and require 
payment or where payment receipt has not yet been confirmed by TSBC.
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Click on the blue 
“download” icon 
to open or save 
the invoice (in PDF 
format).

There are links to 
some of the more 
common banking 
sites (click on the 
link to go to the 
bank’s main 
website).

These are the 
Invoices which 
are still “Open” 
and have not ben 
paid.  Please 
ensure you make 
the required 
payment to TSBC.

• Once payment is confirmed by TSBC (EFT or Bank payment), these will show as “Closed Invoices”.

• You can download the invoices by clicking on the blue download arrow to the right of the row.

NOTE: Nil Returns are shown on the “Closed Invoices” tab as they do not require payment.



Invoices – NIL Filing Invoice
Login > Filing > View, Print, Download Invoice

• If you are filing a “Nil Return”, when you “Approve” it, a “Closed Invoice” will be created as no payment is required.

• You will see a pop-up confirming the Invoice has been created, including the Invoice # and a download icon (downward arrow) 
so you can download the Invoice in PDF format, if required.

NOTE:  You must file a “Nil” Return even if you have paid your wholesaler the ADF Fees.
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Invoices – View, Print, Download
Login > Filing > View, Print, Download Invoice

• You can view, print or download a PDF of the invoice by clicking on the 
blue download arrow icon to the right of the invoice line.

• Invoices are also created for “Nil Returns” ($0) so there is a record of the 
ADF Return.
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Invoices – Closed (Paid)
Login > Filing > Closed Invoices

• The “Closed Invoices” tab shows invoices which are paid (remittance receipt has 
been confirmed by TSBC) and those Invoices requiring no payment.
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• Any “Nil Returns” (reporting periods where the business had nothing to report for the period) do not require payment, so the 
invoices are also “Closed”.

• Closed Invoices can also be downloaded, to view or print in PDF format, by clicking on the blue down arrow icon to the right of the 
invoice.



7. Filing Reports
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Filing – Reports
Login > Remitters > Actions

• To see a summary of your account balance or all of the products you have reported, go to the main 
Remitter page and click on the “edit” (pencil) icon beside your business’ name.
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• Under the “Actions” section on the lower right, there are buttons to run 5 different Reports:

o The “Registration Certificate” is the TSBC Certificate of Registration, now available to download directly.

o The “Remitter Statement” is a PDF file that shows details of your account balance, including all payments, credits and adjustments.

o The “Invoices Report” is a 3-tab Excel file that shows Invoice totals, details and taxes for all invoices within a certain data range.

o The “Collections Report” is available for Remitters that are also Collection Locations and lists all Collections (pick-ups).

o The “Products Filed Report” shows details of all of the products you have reported, including quantity, type and fees.



Registration Certificate
Login > Remitters > Actions

• On the main “Remitter” page, you can “Download Registration Certificate” to get a copy of 
your business’ TSBC Registration Certificate (without having to contact TSBC).

• You can either “Open” the file to view/print the certificate, or “Save” it as a file.

• An example of a Registration Certificate is shown on the next page.
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Click on “Download 
Registration Certificate” then 
either Open or Save the file.



Registration Certificate
Login > Remitters > Actions

• Shown below is an Example of a “Registration Certificate”.

• The certificate shows the business name and address and its TSBC Registration Number.
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Remitter Statement
Login > Remitters > Actions

• On the main “Remitter” page, you can “Download Remitter Statement” to see a listing of all 
Filings for that Remitter to explain the Balance on the account.

• You can either “Open” the file to view/print the statement, or “Save” it as a file.

• An example of a Remitter Statement is shown on the next page.
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Click on “Download Remitter 
Statement” then either Open 
or Save the file.



Remitter Statement
Login > Remitters > Actions

• Shown below is an Example of a “Remitter Statement”.

• All Filings and Payments are shown (latest first), as well as any other adjustments on the 
account.  

• The overall Account Balance and # of Missing Filings are shown near the Statement date.
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Invoices Report
Login > Remitters > Actions

• On the main “Remitter” page, you can “Download Invoices Report” to see a listing of all the Remitter’s 
Invoices for a date range of when the Invoices were created (NOT the Filing Period dates), and if they 
are Paid or Unpaid.

• After you select the Date Range and Invoice Status, you can either “Open” the 3-tab Excel file to edit, 
view or print the worksheet(s), or “Save” it as a file.

• An example of an Invoice Report is shown on the next page.
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Click on “Download Invoices Report” then 
select a Date range of when the Invoices 
were created (NOT the Filing periods). 
Select whether you want Paid or Not Paid 
Invoices (or both). Then either Open or 
Save the file.



Invoices Report
Login > Remitters > Actions

• Shown below is an Example of an “Invoices Report” (in Excel format).  

• It lists all invoices created within the data range selected, and consists of 3 tabs:  

o Invoices (total) – Lists the total of each invoice, balance owing, etc.

o Invoice Details – Lists the details reported on each Invoice,  and 

o Invoice Taxes – Lists the applicable taxes for each Invoice
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Collections Report
Login > Remitters > Actions

• On the main “Remitter” page, you can “Download Collections Report” (in Excel) to see a 
listing of all collections (pick-ups of used tires) from your location.

• Remitters who are “Collection Locations” will have data on this report, if they have had any 
pick-ups for used tires.

• An example of a Collections Report is shown on the next page.
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Click on “Download 
Collections Report”.



Collections Report
Login > Remitters > Actions

• Shown below is an Example of a “Collections Report” (in Excel format)

• The report is a 2-tab Excel file.  It lists the “Collection” information on one tab and the “Collection Details” information on the other 
tab.  Collection Details include the count of each tire type collected.

• If the business has not had any Collections, the tabs will be blank.
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Products Filed Report
Login > Remitters > Actions

• On the main “Remitter” page, you can “Download Products Filed Report” (in Excel) to see a 
listing of all products you have filed for one or more Filing periods, and the amount of fees 
associated with those products.

• Once you select the Filing(s) you want to include, you can either “Open” the file to edit, view 
or print the worksheet(s) or “Save” it as a file.

• An example of a Products Filed Report is shown on the next page.
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Select one or more Filings.  To 
select more than one, hold down 
the “Ctrl” key and click on those 
Filing Periods you want to select.  
To select all, click on the 1st one, 
then hold the “Shift” button, scroll 
to the bottom, then click the last 
one. You can then either open or 
save the file.

Click on “Download 
Products Filed Report”.



Products Filed Report
Login > Remitters > Actions

• Shown below is an Example of a “Products Filed Report” (in Excel format)

• The report is a single tab worksheet that shows the total quantity and type of products reported for the selected reporting period(s), 
regardless of whether or not they have been paid.

• The total quantities and fees are also included.

NOTE: To see the Types and Quantity of Tires reported for each Reporting Period, look at the 2nd tab of the “Invoices Report”.
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8. Manage Your (Remitter) Information
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Manage Your Information (“Self-Serve”)

1. TSBC’s e-Commerce system (“PICTUS”) is a “self-serve” application which gives you the ability to: 

a) Enter your ADF Reports online (as explained in the “File” section)

b) Maintain your company’s information (address, phone #, Contacts, etc.), using the 
“Businesses” (Remitter) function within the “Participants” section

c) Grant and manage access to your records for any or all of your Contacts, using the “Users” 
function

d) Delete contacts and/or “Deactivate” Users who are no longer with your organization

2. This application is designed to allow you access to the business(es) that you are authorized for, 
without having to sign in to multiple accounts (known as a “single sign-on”).  

3. Refer to the “Terminology & Navigation” section of this document to understand the terms and 
definitions in this section.
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Home Page
Login > Home

• The “Home” or landing page is the communication and launching point into other parts of the 
application.

• This page shows a Summary of your Filings so you can see if any are outstanding or waiting to be paid.

• Notifications may be general (for all users) or could be specifically for you. 

• Your Email ID are displayed in the upper right corner beside the menu icon.

• To File your ADF Return, click on the blue “File” button.

• To Edit your information, click on the “Participants” tab at the top (to the right of the “Home” tab).
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Manage - Remitter (Participant/Business) Information

Organization vs. Businesses (Remitter) level Information:

• Each Participant (Remitter) is part of an Organization, and an Organization may have 1 or more businesses (Remitters).

• Access to an Organization allows the user to see information for ALL Remitters within that organization.

• Access to a Remitter (only) allows the user to ONLY see information for that specific Remitter.

• Access is managed through the “Manage Users” function described in this document.
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Click on the “Organizations” tab to 
view the Organization level data

Remitter

Defaults to all Statuses 
except “Inactive”. To see 
all Remitters (including 
Inactive), click on the 
arrows on the right of the 
“Status” column.



Businesses Page
Login > Participants

• The “Businesses” page shows a list of the Organization’s Remitters (locations). Each location is related 
to a registered retailer.

• Remitters need to complete a Filing for each eligible Filing Period.

• You can Edit Remitter information by clicking the pencil icon on the right of the line.

• You can also store contact information at the Organization level, for people who manage 
information for all of the individual Remitters (retailers).
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Edit Remitters
Login > Remitters > Edit

• On the “Businesses” (Remitters) page, clicking Edit allows you to view remitter details and edit certain 
information such as addresses and contacts.   Click on each of the 5 “tabs” to view or edit the information. 
“Update” to save and “Cancel” to go back without saving the changes.

• You can edit some or all of the “Address” or “Contacts” information by clicking on the tab.  Red tabs 
indicate there is missing information. 

NOTE:  You cannot edit your Business Name nor your Physical Address online (only your mailing or other 
addresses). Contact TSBC directly if you have changes to your Business Name or Physical Address.

• The “Notes & Files” tab allows you to enter messages, as well as attach files; for example, a registration 
document if you applying online to register a new Remitter (location).

• The “History” tab shows all changes that were made to your Remitter details (and is “read only”).  The light 
blue highlighted line is the current information.
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You can see both the Organization and the 
Remitter (Business) tabs at the top, and toggle 
between them by clicking on the name.



Edit Remitter – Address
Remitter > Edit > Address 

• Each Remitter must have a Physical address in file.  You can also have other types of 
Addresses, such as Mailing or Accounting addresses on file.

• An Address could also be more than 1 Type (e.g. the Physical address is also the 
mailing address).  To select more than 1 value, hold down the “Ctrl” key to highlight 
the value(s).

• To edit your Address, click on the pencil icon beside existing address lines.

NOTE: If you need to Change your Physical Address you will need to contact TSBC.
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Edit Remitter – Contacts
Remitter > Edit > Contacts 

• Each Remitter must have at least one contact person, and one must be the Owner 
or Manager contact.  Use the “Create Contact” button for new contacts.

• The contact can be one or more types of: Owner, Filing/Accounting or Manager. To 
select more than 1 value, hold down the “Ctrl” key to highlight the value(s).

• To Edit Contact information, click on the pencil icon beside the contact that are 
listed (in the screenshot below there are no contacts yet).
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NOTE:  When entering phone numbers, just enter 
the numbers themselves and do NOT enter 
parenthesis or dashes.  The system will 
automatically format the phone numbers.

If it does not show the format automatically, you 
may need to refresh our browser.
When you are finished and hit the “Create” 
button, the system will store the correct format.



Edit Remitter – Notes & Files
Remitter > Edit > Notes & Files

• You can also add a Note or attach Files to your TSBC record by clicking on the 
“Notes & Files” tab.

• This is an optional field and can be left blank.
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Edit Remitter – History
Remitter > Edit> History

• The History screen is a “view only” screen, so you cannot change the values.

• It is a record of all significant changes to a record, including Status changes, etc.

• The active line is highlighted in pale blue..
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9. Manage Your Users’ Access
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Manage – User Access

Contacts vs. Users:
• Each Remitter and each Organization must have at least one Contact record (name, e-mail, phone #).

• Initially, each business (registered location) has been assigned one or more Users (with all Roles) based on contact 
information on file at TSBC.

• The “Master User” role can grant access to other people or change their access level (“permissions”) by editing the User’s 
“Role” (Master User, Data Entry, Approver),including the ability to add other Users.

• When you are signed into the application, you can review the Users by going to the Organization line (grey) and clicking the 
“Edit” button (pencil) on the right side of the line.  The “Users” tab (at the Organization level) shows all users and their Role 
(permission level).
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FIRST:  Edit the Organization

THEN: Edit the Users

Go to the “Users” tab 
in the Organization 
record

REMEMBER: You can “invite” a person to be a User (e.g. their e-mail ID is used to 
create their User record). but they will need to be either:

o already listed as a Contact on the Organization or Remitter record,  or
o enter their Contact information the 1st time they log-in.



Users page
Login > Users

• The Master User can edit an individual’s access (role) on the “Users” page by clicking on the pencil icon. 
Data Entry Users and Filing Approver Users will have view access only.

• The Master User can “Invite New Users”, and can designate their roles: another Master User, Data Entry 
User or Filing Approver User.

• Refer to the Terminology section to understand the permissions for each User type.
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Edit the Users 
Roles or 
Remove User

Invite NEW 
User

OR



Manage Users – Invite (New)
Login > Users > Invite New User

• The Master User can “Invite New User” to log-in to the system and create an 
account

• The new user will receive an e-mail with further instructions.  Once they 
confirm acceptance, the Master User can define their role (type of user).

• Refer to the Terminology section to understand the permissions for each User 
type. 
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Manage Users - Invite (Existing)
Login > Users > Edit

• Users will have the same Roles (permissions) for any and all Remitters they have access to.

• If the User that you “Invite” already exists in the system, because they have access to a different Remitter or 
Organization, they will have the same level of access to your records.

• If you add a User and give them the “Master User” role, you will see a pop-up asking you to confirm this, as Master User 
has full rights to update all data for the Organization.
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You will see this pop-up if you Add an existing 
User to your Remitter. 

You will see this pop-up if you are giving a User 
the role of “Master User”. 



Manage Users-Edit/Remove
Login > Users > Edit

• The Master User can “Update User Roles” by clicking on one or more roles of: Master 
User, Data Entry User, Filing Approver (or all 3).  When done click on “Update”.

• You can “Remove” a User ID to revoke the person’s access.  This should be done for 
anyone who leaves your organization to prevent them from accessing your records.

• Refer to the Terminology section to understand the permissions for each User type.
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Edit the Users 
roles or 
Disable User

The pop-up window 
allows you to edit the 
User’s Role and also 
define their Filing 
Roles.



10. Register New Locations
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Register - New Location
Register

1.  Existing Retailer – Online application:  

a) If you are already a registered Retailer with TSBC, you do NOT need to Re-register to use the e-Commerce application.  
You have already been set-up with a User ID, as described in the “Manage Users” section of this document so you 
already have a PICTUS Account.

b) To apply online to register a new location for one of your existing Organizations:  Log-in to the system, click on the blue 
“Create Business” and select “Remitter” from the drop-down list. Then Select which Organization you want to add the 
new Business to and begin the process. 

c) If you want to register a new location for a NEW Organization, contact TSBC and they will create the Organization for 
the new Business.  Then you can “Create Business” for the new Organization.

d) Refer to the “Self-Registration” sections of this document for detailed step-by-step instructions to “Create Business”.

2.  New Retailer – Online application:

a) If you are a new tire retailer business in BC who has NOT YET registered with TSBC, please go to the “Participant 
Resources” section of the TSBC website and review the information on “Registering with TSBC”:   
https://tsbc.ca/participant-resources/

b) You can register online using our “Self-Registration” process described in this document (including the Terms and 
Conditions form which you can access once you create an account online).

c) The “Terms and Conditions” (self-registration) form can be downloaded from the TSBC website once you are logged in.  
During the “Create Business” process, there is a link to the Terms & Conditions fillable form, so you can download it.  
You’ll need to complete the form and attach online to your application for registration.

3.  Questions?: If you have any questions, please contact TSBC at:  1-866-759-0488 or  registrations@tsbc.ca
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Please also refer to the section in this document called “Getting Started – Access”  To 
register a new location, you can apply online or mail in the completed paper 
application form.  To apply online, you must first have an Account in PICTUS.
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Self-Register – Overview
Register > Create Account and/or Create Business

• The diagram below shows the overall process and the steps for the Applicant (you), PICTUS (the system) and the Agency (TSBC).

• The new “Self-Registration” process includes the ability to “Create Account” (Steps 1-3) and, once you have an account, you can 
submit a registration application using the “Create Business” (Step 4) function. Steps 5 and 6 are done by TSBC (the Agency).

• If you already have an Account, you do NOT need to complete Steps 1-3, but can go directly to “Step 4 – Create Business”.

• Refer to the next sections for step-by-step directions on how to complete each part of the process.
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• If you require access to TSBC’s e-Commerce application to register a new 
location so you can submit your ADF Returns, you can now register directly 
online by submitting the necessary information.



Self-Register – Login Page
Register > Create Account

• The main system page is the starting point for all users of the e-Commerce (“PICTUS”) application.

• If you have a system account already, enter your Email ID and Password and click “Login”.  If you have forgotten your password, or 
do not have one yet, click on the blue “Forgot?” link.  Then follow the instructions in the e-mail to reset your password and Login.

• To create a new system account, click on the word “REGISTER” and follow the instructions.  
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NOTE:

1. Before beginning the “REGISTER” 
process, refer to the ”Participant 
Resources” section of the TSBC 
website https://tsbc.ca/participant-
resources/ and click on 
“Registering with TSBC” for relevant 
information.

2. You should have already reviewed 
the “Registering with TSBC” 
checklist to confirm your business 
needs to be registered with TSBC

3. Part way through the online 
registration process, there will be a 
link to the “Terms and Conditions” 
form.  You will need to complete it 
and attach to your online request, 
as it is required for this process.

4. If you have questions, please 
contact TSBC at 
registrations@tsbc.ca.



Self-Register – Create Account – Step #1 – 4
Register > Create Account

• If you require access to TSBC’s e-Commerce application to register a new location in order to submit your ADF Returns, you can now 
register directly online by submitting the necessary information using the Self-registration function.

• To access the system, you need to first have an Account for the system.  If you already have an account, go directly to the section 
called “Step 4 – Create Business”.

• If TSBC has NOT created an account for you, or if you have not been “invited” to use the system, you can create your own account 
by following Steps 1 – 3 shown on the following pages.

o Step #1:  E-mail and Contact

o Step #2:  Set Password

o Step #3:  Create Organization

• Once you have an Account and an Organization, go to the section called “Step 4 – Create Business”.  This step is to submit 
information for a registration application for a new business location.
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12. Self-Registration – Step #1: E-mail & Contact
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Self-Register – Create Account – Step #1: E-mail & Contact
Register > Create Account

• The Diagram below shows the process to complete the 1st step “E-mail & Contact”.  Screenshots are also shown on other pages.

• In this step you will create an account using your E-mail ID and provide your Contact information.
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Self-Register – Create Account – Step #1: E-mail & Contact
Register > Create Account

• To create a new system account, click on the word “REGISTER” and follow the instructions.  

• You will need to have the following information ready to input:

o A completed and signed “Terms and Conditions” form (available from a link within the “Create Business” process).

o The Legal and Business Name(s) of the company, its Operations Start Date, Contact Names, E-mails and Phone numbers,

o The company’s Physical address and addresses for Mailing or Accounting (if different than the physical address)
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Self-Register – Create Account – Step #1: E-mail & Contact
Register > Create Account

• The “Welcome” page provides additional information on the program and explains requirements of the Advance Disposal Fee 
program.  There are 4 greyed out arrowed tabs at the top of the screen.  Each tab will turn blue to indicate which section you are 
using.

• Click on any of the blue words (“hypertext links”) in the text on the screen to be taken to the TSBC website for further information and 
explanation.

• If you have confirmed that your business is eligible to be registered, and have the other necessary information ready, then press the 
blue “Start” button. Partway through the “Create Business” process you will also need to complete the “Terms and Conditions” form 
(available from a link you’ll see during that process).

• If you are unsure about having to register, or are not yet prepared to register online, click on the “Cancel” button.  This will take you 
back to the main Login page.
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Self-Register – Create Account – Step #1: E-mail & Contact
Register > Create Account

• Once you click “Start” you will be taken to 
the “Account” tab to enter information 
about the account you are requesting 
(Step 1 of 4).

• The e-mail for the account must be unique 
and cannot one already used by the 
system.

• To complete the form:

o Enter your e-mail ID, First & Last 
name and Telephone No. (number).

o Fax No. and Cellphone No. are 
optional.

o Select the “Type” of role the contact 
has in the organization.

o The click on the blue “Create 
Account” button.

• Click on the black bubbles beside the cell 
titles to see an explanation of what is 
required.  An example is shown for “Type”.

• If there are any errors or omissions on the 
system, the system will include the issues 
and you can edit the information and 
click “Create Account” again.

NOTE:  Some of the common errors are shown 
in the following pages.

• Please contact TSBC if you are having 
issues completing this form.
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Self-Register – Create Account – Step #1: Error Messages
Register > Create Account

• If you complete the “Request Account” form and get errors when trying to submit it by hitting the blue “Create Account” button, it 
means there is an issue with the form.

• A red “bubble” with text will appear in the upper right hand corner of the screen and text will appear below the “Email ID” field, as 
shown below.

• Refer to the next page which shows the 3 types of errors and steps to resolve them.
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Self-Register – Create Account – Step #1: Error Messages
Register > Create Account

• There are several errors which may occur when trying to create a new Account, as shown below, including how to resolve them. 
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  • In this example, the Email ID is already in use and linked to an existing 

business, so you cannot create another account with the same Email ID 
(UserID).

• Wording beneath the Email field in the form shows ”A user with that e-mail 
already exists”.

• If you already have an account and want to register a new Location, go to 
“Step 4 – Create Business”.

• In this example, the Email ID exists in the system but has been marked as 
“Inactive” so it cannot be accessed. This can occur if the business is sold 
or the account was not being used by the business. 

• Wording beneath the Email field in the form shows ”A user with that e-
mail already exists”.

• The Email ID must be changed back to “Active” by the Agency before 
you can login to that account, so please contact TSBC.

• This can happen if you begin the Request Account process, click the “Create 
Account” button, but then do not refer to the New Account email with the 
password link to continue the process of self-registration. The UserID gets 
added to the system, but it is not linked to any Organization yet.

• Wording beneath the Email field in the form shows ”A user with that e-mail 
already exists”.

• Go to the Login page, enter your mail ID and click on “Forgot?” to reset your 
password.

Error #1:  UserID (Email) Already Exists

Error #2:  Inactive UserID (Email)

Error #3:  Incomplete Account

_________________________________________________________________________________________________________________________________________________________________________________________________

_________________________________________________________________________________________________________________________________________________________________________________________________

_________________________________________________________________________________________________________________________________________________________________________________________________

_________________________________________________________________________________________________________________________________________________________________________________________________



13. Self-Registration – Step #2: Password
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Self-Register – Create Account – Step #2: Password
Register > Create Account

• Once you submit the “Create Account” form, the 2nd step is to Create a Password for your new account.

• The diagram below shows the process to Set your password and the screens are shown on the following pages.

• Your password must be at least 10 digits long and contain:  

o at least 1 upper case letter, 

o at least 1 lower case letter, and 

o at least 1 number. 
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Self-Register – Create Account – Step #2: Password
Register > Create Account

• Once you submit the “Request Account” form, you will see a screen with the text shown below.

• The E-mail of the new Account will receive an e-mail from ecofees@tsbc.ca with a link to set your password   Click on that link and 
follow the directions.

NOTE:  The link in the e-mail expires after 24 hours and can only be used one time.

• If you do not receive the e-mail after several minutes, please check your “Junk” e-mail folder, in case it was flagged as spam. If that 
happens, add the e-mail ecofees@tsbc.ca to your e-mail’s contact / safe list, so future e-mails are not blocked.
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Self-Register – Create Account – Step #2: Password
Register > Create Account

• The e-mail below is an example of the “Password Reset” message for new accounts.

• To set your password, click on the blue “click here” to go to the “Set Password” screen.

NOTE:  The link in the e-mail expires after 24 hours and can only be used one time.  
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Self-Register – Create Account – Step #2: Password
Register > Create Account

• The “click here” link in the Password Reset e-mail will bring you to the “Password” screen (Step 2 of 4).

• Enter your password on both lines, making sure they match each other, and that they meet the criteria.  Then press the blue “Set
Password” button.

• Your password must be at least 10 digits long and contain:  

o at least 1 upper case letter, 

o at least 1 lower case letter, and 

o at least 1 number.

• Once you have set your password, your account will be created. You will then be taken to the “Create Organization” step, which is 
the last step to create your account.
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14. Self-Registration – Step #3: Organization
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Self-Register – Create Account – Step #3: Organization
Register > Create Account

• The last step in Creating your Account is to create an Organization.

• Organizations are needed to link your account  to your Business(es).

NOTE:  Your Organization name must be unique so it should contains “(Org)” after the name to indicate it is the organization.

• The screens needed to complete this step are shown on the following pages.
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Self-Register – Create Account – Step #3: Organization
Register > Create Account

• Once you set your Password for a new account, you will be taken to the “Create Organization” screen (Step 3 of 4).

• The Organization name must be unique and not used by any other Business in the system.

• The Organization name can be the same as the Business Name, but to make it unique, you can add “(Org)” after the name.

NOTE:  the Agency may adjust the Organization Name when the application is processed, to ensure it is unique within the entire system. 

• Once you have selected the Organization name, click on the blue “Create” button.
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Self-Register – Create Account – Step #3: Organization
Register > Create Account

• An example of an Organization Name is shown below.

• If the name you select is NOT unique, you will not be able to submit this form.

• The black icon beside the “Organization Name” label has additional information about the field. 
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Self-Register – Create Account – Step #3: Organization
Register > Create Account

• Once you create an Organization, you will be taken to the “Home” page for new accounts.

• There are 2 tabs on this page:  The “Home” page (note it is underlined to blue to indicate it is the page you are on), and the 
“Participants” page (where your Businesses are listed, once they are approved).

• From the “Home” page, you need to “Create Business”.  To do that, follow the “Create Business” process shown as Steps 4 in the next 
section.
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15. Self-Registration – Step #4: Create Business
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Self-Register – Create Business – Step #4: Create Remitter 
Register > Create Account

• The final step to submit your Registration application is to complete Step 4 “Create Business”.

• To submit your application, you must provide information about your Business Name, Start Date, Contacts, Address(es) and attach a 
completed, signed “Terms & Conditions” form.  

• Refer to the following pages for a step-by-step process to complete this Step.
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Self-Register – Create Business – Step #4: Create Remitter
Register > Create Account

• Once you have successfully created an Account, you will be taken to the new account Home Page.

• You will need to “Create Business” (Step 4 of 4), by following the instructions shown in the “Notification” section of the page. This 
requires you to enter or validate information on 4 tabs.  See steps 1-4 in the screenshot below.

• To begin, click on “Create Business” and select “Create Remitter”. 

• Once you create the Remitter record, you need to provide details about the business before you can “Submit” the application.

• See the following pages for screens showing the step-by-step process.
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Self-Register – Create Business – Step #4: Create Remitter
Register > Create Account

• The first step is to create the Remitter (Business) and provide 
some basic information about the company.

• The “Business Name” should be the “Doing Business As 
(DBA)” name.  It must be unique.

NOTE:  Once your application is approved, TSBC may adjust 
your DBA name to follow Agency standards, by adding a City 
name or other identifiers.

• Select the “Type” of business from the drop-down list.

• TSBC will fill in the “Registration Date” once your application 
is reviewed and approved.

• The “Operations Start Date” is defined as the day the 
business started selling tires.

• Enter the “General Telephone No.” as just numbers (no 
parenthesis nor dashes).  The system will automatically 
format it for you, but you may need to refresh your browser 
to see the format.

• The “Business Link” is an optional field.  It is used to locate 
your geographic location.  You can use Google Maps to 
find your Business Link, if one exists, by going to this site and 
entering your company name: 
https://www.google.ca/maps/

• You can copy the URL of your Google Maps Business Link 
into this field.

• Once the form is complete, click on “Create”.  This creates 
the basic Business and links it to your Organization and your 
Email ID.
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Self-Register – Create Business – Step #4: Create Remitter
Register > Create Business

• Once the Remitter (Business) is created, you will see the full record for your Business.  Each Business has information on 5 tabs:  Remitter
(the information you entered on the previous step), Address, Contacts, Notes & Files and History. 

• To complete your application, you must enter “Address” data and attached the signed Terms & Conditions file as a “Notes & Files”.

• The “Update Remitter” section on the left show the data you entered.  You can edit the Telephone No., but other fields cannot be 
edited until TSBC reviews your application.

• The “Current History Values” section on the right is for the Agency to enter/change if required.  The Business’s application Status is 
“New” as it has not yet been submitted.
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Self-Register – Create Business – Step #4: Create Remitter
Register > Create Business

• To complete your registration application, please check / complete each tab until the 3 red or green “check marks” are all green.  
When the data is complete the “Submit” button the far right will turn blue and you can “Submit” the application.

• If you hover above the red/green “bubbles” next to the titles, you will see a pop-up with further explanation as shown in the snapshot 
below.
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Self-Register – Create Business – Step #4: Remitter Address
Register > Create Business

• Click on the “Address” tab (it will have a blue underline on it to indicate that is the tab you are on).  

• If the check mark is red, then you need to add the physical Address for the Business by clicking on “Create Address”.  Every Remitter 
(Business) must have their physical address entered in the system.

• This will open a pop-up screen where you can enter the Business’ address. 

• If the mailing address or accounting address is different than the Business’ physical address, you can create an address for each of 
them.  A business can have several addresses.
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Self-Register – Create Business – Step #4: Remitter Address
Register > Create Business

• When you click on “Create Address” you will see the pop-up screen 
below.

• The address uses Google addresses so start typing on Line 1 and your 
address should appear.  Select the correct address then hit “Tab” and 
the form should automatically populate the address fields.

• If Google does not find your address, you can manually enter the 
address into the fields.

• For “Province”  use the 2-letter short-form of “BC”.

• For BC, the “Town” field will include a list of all communities, towns and 
cities in BC.  

• For other provinces, you will need to type in the town/city/community 
name.

• Please format the “Postal Code” to be in the “X9X 9X9” format.

• Select one or more of the address “Type”.  To select more than 1 value, 
select one then hold down the “Ctrl” key and click on the other 
choice(s).

• When finished, click “Create” and you will be taken back to the main 
Remitter (Business) screen.

• If you want to submit another address, just select “Create Address” 
again.

NOTE:  Once you create the Physical address, you cannot modify it.  If it is 
incorrect or has changed, please contact TSBC to have them edit the 
physical address. ©
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Self-Register – Create Business – Step #4: Remitter Address
Register > Create Business

• Once you have created a physical address for your Business, you are returned to the Address tab of the main Remitter page. 

• You’ll notice that the “Physical Address on Business” now has a green check mark, as shown in the screenshot below.

• If you want to add other address types for this business (mailing of Filing/accounting), click on “Create Address” and complete the 
form again.

• The only outstanding step is to attach the “File on > Registration Application on Business”, which is still a red check mark.
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Self-Register – Create Business – Step #4: Remitter Contacts
Register > Create Business

• The “Contacts” tab shows a green checkmark because you provided Contact information when you set-up your account back in 
Step 1 of 4.

• You can edit the Contact information by clicking on the pencil icon to the right of the line. 

• If you want to add other Contacts for the Business, click on the blue “Create Contact” button.  A pop-up screen will appear for you 
to complete.

NOTE: You must have a Contact who is either the Manager or the Owner.  If you created the account and your Contact Type is 
“Filing/Accounting”, then you need to create another Contact who is an “Owner” or “Manager” Type in order to make the “check 
mark” green, and be able to submit the application..
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Self-Register – Create Business – Step #4: Remitter Contact
Register > Create Business

• To add other contact records, complete the pop-up form and hit 
“Create” once done. 

• The contact’s “E-mail” must be unique and must be in an e-mail 
format.

• If the contact you are creating already exists in the system, as it is 
listed on a different Business, the system will link that person to your 
business also.

• Please enter the contact’s First and Last Name.  

NOTE:  Do NOT use the person’s role nor any generic names (e.g. 
“general information”) for the First and Last Name.

• Enter the numbers for the “Telephone No.” and it will format itself.  
You do NOT need to enter parenthesis nor dashes for the Phone 
numbers.

NOTE:  If the phone number does not auto-format when you enter it, you 
may need to refresh your browser.  When you “Create” (save) the 
record, the system will correctly format the phone number(s).

• The Fax No. and Cellphone No. fields are optional, but if you have 
that information, please provide it so we can other ways to reach 
the contact, if required.

• Select the “Type” of contact based on which role most closely 
reflects what the person does in the Business.

• Once the form is complete, hit the blue “Create” button.  This will 
take you back to the main Remitter page.

• To create additional contacts for your Business, from the Remitter 
“Contacts” page, click on “Create Contact” again.
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Self-Register – Create Business – Step #4: Remitter Notes & Files
Register > Create Business

• The last area you need to complete is the “Notes & Files” tab.

• Each registration application must have completed and signed the “TSBC Terms and Conditions” form, which is available from the 
TSBC website.  Click on the blue wording “TSBC Terms and Conditions” in the 2nd line in the screen. 

• Download the form, read it and complete the section on page 2 to indicate you are authorized and agree with the terms.

• When ready, click on the blue “Create Note” button to attach the Terms and Conditions form.
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Self-Register – Create Business – Step #4: Remitter Notes & Files
Register > Create Business

• An example of the “TSBC Terms and Conditions” 2-page form is shown below, for your information.

• Go to the TSBC website to download the form, read and complete it (by an authorized personnel). Then scan the completed form
onto your computer so you can attach it to your Business record in our system. 
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Self-Register – Create Business – Step #4: Remitter Notes & Files
Register > Create Business

• To send your completed “TSBC Terms and Conditions” form, you need to create a note for the Agency to review the form.

• When you click on “Create Note” you will see a pop-up screen to complete.

• The 3 images below show the various data fields on the form.

1. The “Date” field automatically show the date you create the note.  The “Note Category” also defaults to “User Note”.  These cannot 
be changed.

2. The “Note Type” field is a list of possible notes.  Select “Registration Application” from the list.

3. The “File” field allows you to select a file from your computer.  Follow the prompts to find and select your completed “TSBC Terms and
Conditions” file.  This will attach a copy to this note.  You must enter something in the “Text” field, so if you have any comments, 
please enter them there.

4. Once the form is complete, click on the blue “Create” button.
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Self-Register – Create Business – Step #4: Remitter Notes & Files
Register > Create Business

• Once you have added a “Registration Application” type Note, you will notice that the “File on > Registration Application on Business” 
now shows a green check mark.  
If this is still red, it probably means you selected a different “Type” of note.  

• To edit the Note, click on the pencil icon to the right of the note record. 

• To add other notes (with or without file attachments), click on “Create Note” and complete the form again.

• Now that all 3 areas have green check marks, the “Submit” button turned blue so you can “Submit” your application.

• The “History” tab is “read only” and shown on the following page for your information.
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Self-Register – Create Business – Step #4: Remitter History
Register > Create Business

• The last tab of Remitter (Business) information is the “History” tab.

• It displays the Status of the Business and other important fields.  It is a “read only” screen so you can view the data but cannot 
change it.  Only the Agency (TSBC) can change these values.

• Once TSBC reviews your registration application, they will update the Business Status and possibly some of these other fields, so you 
will see the changes on this screen.

• If there are multiple History lines, the one that is shaded light blue is the active line. 

• Now that all check marks are green, you can click on the blue “Submit” button.  Once submitted, you cannot change any data until 
after the Agency processes your application.
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Self-Register – Create Business – Changes after Submission
Register > Create Business

• Once you submit the completed application for registration, you will notice the tabs can no longer be edited.  

• There is a warning also in red text to remind you of that. 

• Once the Agency processes your application, you will be able to edit some data.

NOTE:  If you have made any errors in your registration application, or forgot to add something, or have any questions, please contact 
the Agency at:  registrations@tsbc.ca
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Self-Register – Create Business – Thank You E-mail
Register > Create Business

• After you “Submit” your online registration application, you will receive a “Thank You” e-mail from the Agency’s registrations@tsbc.ca
e-mail address confirming they have received your application.

• If you do not receive the “Thank you” e-mail, please check your “Junk” folder in case it has been inadvertently blocked or marked 
as spam.  Please ensure your e-mail accepts e-mails from TSBC.

• TSBC will also be calling you to ensure you receive the e-mail, and in case they have any questions, as part of their review process.

• They want to ensure they have your correct contact information, and that your system accepts the various e-mails used by the 
Agency.

• An example of the “Thank You” e-mail is shown below.

NOTE:  Once the Agency reviews and approves your application, you will receive a “Welcome” e-mail which will 
include your TSBC Registration # for your Business, and further information regarding the ADF Return Filing 
requirements.  An example of the “Welcome” e-mail is included in the next section.
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Sample of a “Thank you” e-mail sent from registration@tsbc.ca :

Thank you for submitting your registration with TSBC. It will be reviewed 
within five business days. 

Karen Vantreight, 

Program Administrator



Self-Register – Create Business – Filing after Submission
Register > Create Business

• Once you submit the completed application for registration, your file is not active until the Agency renders a decision on your 
application.

• Although the blue “File” button, shows up, you cannot file anything until the Agency creates new Filing period for your Business.

• If you have any questions about your application, please contact the Agency at:  registrations@tsbc.ca
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Self-Register – New Remitter Filings
Register > Create Business

• From the Home Page, if you click on the blue “File” button, it shows there are no Filings created yet for your new business. 

• Once the Agency processes your registration application, if approved, they will create Filing periods for your business and send you 
additional information on how to file.

• Please refer to the “Filing” section of this document also for further information.
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Self-Register – New Account - Logout
Register > Create Business

• Once your application has been “Submitted” you can not edit any information, as the Agency is processing your application.

• You also will have no Filings due until the Agency approves your application.

• You can logout of the system by clicking on the upper right hand menu and selecting “Logout” from the drop-down list.
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Self-Register – New Account – Logout
Register > Create Business

• The system will ask you to confirm that you want to Logout.

• Press “OK” to log off the system.  After logging out, we recommend you close the browser.

• To sign back in, go to the main Login page at:  https://tsbc.pictus.online/

©
 C

op
yr

ig
h

t 
20

19
 G

et
S

m
ar

t 
S

ol
u

ti
on

s 
In

c.

102

v4
.7

 (
F

eb
 1

5,
 2

02
4)

  
U

S
E

R
 G

U
ID

E
  



16. Self-Registration – How to Start Filing
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Self-Register – Create Business – How to Start Filing
Register > Create Business

• After submitting your registration application, if you Log-out and Log-in again, you will notice that your Home Page has changed.

• It now shows a summary for your Business, and indicates red or green check marks if you have any:

o Filings to Submit

o Invoices to Approve

o Invoices to Pay  and

o The Organization Balance owing

• You do not have any Filings yet because your registration application is still in “Submitted” status.

• Once the Agency reviews and approves your application, you will see Filings Created for your new business account.
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Self-Register – Create Business – Welcome E-mail
Register > Create Business

• After the Agency processes your application, if approved, you will receive a 2-page “Welcome” e-mail from the Agency’s 
registrations@tsbc.ca e-mail (see example below), confirming they have processed your application.  If denied, they will also send 
you an e-mail.
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• If you do not receive the e-
mail, please check your 
“Junk” folder in case it has 
been inadvertently blocked 
or marked as spam.  Please 
ensure your e-mail accepts 
e-mails from TSBC.

• The “Welcome” e-mail 
package has critical 
information in it to help you 
know what is required when 
Filing your ADF Returns.

• Please be sure to thoroughly 
read and understand the 
Welcome package.

• If you have any questions on 
the registration of your 
Business, or how to File, 
please contact TSBC as 
soon as possible.  

• Delays in Filing can result in 
additional fines or interest 
being charged to your 
account.



Self-Register – Create Business – TSBC Process
Register > Create Business

• Once the Agency (TSBC) reviews and processes your application, they will update your Business record to add certain information 
and “activate” your Business. They will add values for:

o Registration Date, 

o Assign a Registration Number,

o Set Filing Frequency to “Monthly”, and 

o Update your Status (to reflect the registration decision), 

• If your Business is “Active” and selling tires, the Agency will also generate Filing records for you to complete.

• You will be required to submit ADF Returns for the months from your “Operations Start Date” to the current Filing period.

• In the example below, the Home screen shows there are now 4 Filings outstanding which need to be completed.

• If you click on the blue “File” button you will see the Filing Periods and can complete your ADF Returns (Filings).
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Self-Register – Create Business – Filing ADF Returns
Register > Create Business

• The list below shows the 4 outstanding ADF Returns (Filings) for this Business. 

• You will notice there are 4 tabs at the top of the screen:

o The “File” tab which lists outstanding Filings

o The “Approve” tab which lists any Filings which were completed but not yet Approved

o The “Open Invoices” tab which lists Filings that were completed but where payment has not yet been received by TSBC, and

o The “Closed Invoices” tab that lists all Filings (Invoices) for ADF Returns that have ben completed and fully paid.

• Refer to the “Filing Reports” section of this Guide for the steps to successfully submit your ADF Returns and payments.
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17. Self-Registration – How to Edit 
your New Account
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Self-Register – Create Business – How to Edit your New Account
Register > Create Business

• Once you log-in to the system, you land on the “Home” tab. 

• If you click on the “Participants” tab you can edit most of your Business’ information.

• You will see that your Business now shows a Registration Number  (Reg. No.) and has a Status of “Active”.

• To review your information, and edit some of the data, click on the pencil icon to the right of the line showing your Business.

• When you start to Edit your information, you are taken to the main Remitter page, as shown on the next page.
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Self-Register – Create Business – Edit Information
Register > Create Business

• When you want to review or edit your Business’ information, you are taken to the main Remitter screen.

• It has the same 5 tabs you completed during the Self-Register process, with additional information the Agency has added.

• Refer to the “Manage Your (Remitter) Information” section of this Guide for the steps to successfully change your Business information.

• Refer to the “Reports” section of this Guide to see examples of the Reports available to you under the “Actions” area in the lower 
right section of this screen.
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18. Log-out
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Log-out
Logout

• For security, when you are done, sign out of the system by going to the Menu on the upper right corner of 
the screen, and “Log out” of your account.
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19. Terminology & Navigation
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Terminology
TSBC e-Commerce

1. Access – accounts for registered users to log-in to the system and controls the types of functions they 
can perform.

2. ADF – “Advance Disposal Fees” are the eco-fees due to TSBC on the sale of a program tire.

3. ADF Return – a report of the volumes of tires sold for which Advance Disposal Fees (ADF) are due for a 
period of time.

4. Bank Payment – a payment made from your bank account directly to an approved “Payee”, as setup in 
your bank account (usually as a “bill payment”).

5. Business – any company that interacts with TSBC is called a “Business” in the e-Commerce application. 
Companies who file ADF Returns are a Business Type called “Remitters”.

6. Closed Invoices – invoices for which TSBC has received payment in full and there is no outstanding 
balance owing, including Nil returns (shown on the Filing “Closed Invoice” tab).

7. Contact – a person who is listed on record for TSBC to communicate with regarding the Remitter 
account.  There are 3 types of contacts:  Filing/Accounting Contact, Manager Contact, Owner 
Contact. (NOTE: A Contact does not have access to the system unless they are set-up as a User.)

8. Data Entry User – the person who enters the data and submits ADF Returns for approval on behalf of the 
Remitters and Organizations assigned to the online account.

9. EFT – “Electronic Funds Transfer” is a function provided by banks for businesses to electronically pay from 
their accounts to pre-authorized recipients.  This arrangement must be setup through your banking 
institution.

• This application uses some specific Terminology and concepts which you should become familiar 
with as you use the system.

• The most common terms are explained here for your reference.
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Terminology (cont’d)
TSBC e-Commerce

10. File – the process for reporting, approval, remittance and invoicing of ADF Returns. 

11. Filing/Accounting Contact – the person currently on record at TSBC who submits ADF Returns for the 
registered retailer location.

12. Filing Approver User – the person who approves the submitted ADF Returns and initiates remittance on 
behalf of the Remitters and Organizations assigned to the online account.

13. Filing Period – this is the month & year in which tire sales occurred.

14. Invoice – this is a verification of the amount payable to TSBC (including taxes), generated for each Filing 
(ADF Return), for each reporting period, after remittance has been submitted.

15. Manager Contact – the person currently on record at TSBC who manages the registered retailer location.

16. Master User – the person who has overall access and permissions to manage registrations and user 
access and permissions on behalf of the Remitters and Organizations assigned to the online account.

17. Nil Return – an ADF Return where the Retailer has reported zero tires for the reporting month.

18. Open Invoice – an invoice that has been created but where some or all of the amount owing is still 
outstanding (shown on the Filing “Remit” or “Payment Pending” tab).

19. Organization – a convenient grouping of related Remitters whose online accounts are managed by the 
same Email ID , or where the Remitters share common corporate address or bank account.

• This application uses some specific Terminology and concepts which you should become 
familiar with as you use the system.

• The most common terms are explained here for your reference.
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Terminology (cont’d)
TSBC e-Commerce

20. Owner Contact – the person currently on record at TSBC who owns the registered retailer location.

21. Participant – a business that is registered with TSBC, which for ADF Reporting is the Remitter.

22. Payment Pending – an invoice that has been created and paid, but TSBC has not received or 
processed the payment yet (shown on the Filing “Payment Pending” tab).

23. Registration – the process of registering online with TSBC as a retailer (for new businesses only).

24. Remittance – the payment of one or more approved ADF Returns, through EFT or Bank Payment. 

25. Remitter – the registered retailer who is required to submit an ADF Return.

26. Self-Registration – the process which allows Remitters to apply directly online to register a new location 
for the purposes of ADF Reporting.  It includes the functionality to create a new system account if you 
do not already have one, and to submit a registration application online (once you have access).

27. TSBC – Tire Stewardship BC

28. Users – generic term for someone who has access to the system and has one or more roles of Master 
User, Data Entry or Filing Approver, each of which have distinct permissions.  (NOTE: Users must provide 
Contact information when they first access the system, but not all Contacts are Users, as they may not 
have access to the system.)

• This application uses some specific Terminology and concepts which you should become 
familiar with as you use the system.

• The most common terms are explained here for your reference.
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Navigation
TSBC e-Commerce

1.  User Account information (on the upper right corner of the Summary page, to left of your User ID) allows you to 
manage your account, change your password and logout.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

2.  Back button (on the upper left area of your browser screen) takes you to the previous screen. Pages with multiple 
tabs have a “back” button to the left of the tab.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

3.  Where several actions are required, coloured circles are green (for all clear) or red (action required). 

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

4.  Buttons along the upper sections of the screen are different pages / functions.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

• This system navigation is quite intuitive and easy to use. 

• The main icons and functions are shown below for reference.
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Navigation (cont’d)
TSBC e-Commerce

5.  Box with pencil indicates you can Edit the information, whereas the “eye” means you can View the data (but not 
Edit it).

--------------------------------------------------------------------------------------------------------------------------------------------------------------------
6.  Tabs indicate different sections of a function that need to be completed.  The blue underline indicates the 
active tab that you are on.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

7.  Filters indicate you can search using one or more selection criteria.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

8.  Disabled buttons are “greyed out” until required actions are performed (such as approving Filings).

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

• This system navigation is quite intuitive and easy to use. 

• The main icons and functions are shown below for reference.
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Navigation (cont’d)
TSBC e-Commerce

9.  Question marks (or “bubbles”) include additional text to explain terminology (hover over the mark to see text).

--------------------------------------------------------------------------------------------------------------------------------------------------------------------
10.  Some screens have a “Help Center” button on the bottom right which has further explanation about the page.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------
11. The blue downward arrow icon is to download information, including a PDF of your invoice(s). 

--------------------------------------------------------------------------------------------------------------------------------------------------------------------
12. Pop-up windows are used to select one or more values (eg. for User Access) or to confirm an action before 

saving the change.

--------------------------------------------------------------------------------------------------------------------------------------------------------------------

• This system navigation is quite intuitive and easy to use. 

• The main icons and functions are shown below for reference.
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20. Frequently Asked Questions (FAQs)
& Other Help
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Frequently Asked Questions
FAQs

1.  Q:  Why is TSBC moving to online “e-Commerce” for ADF Returns?
A:  Online submission of ADF Returns will save time for both retailers and TSBC and allow retailers to have direct 
access to their ADF information, including updating of contact information and managing access to their records. 

2.  Q:  How do I access the new system?
A:  The system is at: https://tsbc.pictus.online You will receive an e-mail from  ecofees@tsbc.ca inviting you to log 
into the system.  Click on the link in the e-mail to go to the sign-in page.  It will ask you to set your password and then 
you can log-in.  First-time users will also need to provide their contact information (first and last name and phone 
number).  

3.  Q:  What should I do if I didn’t receive the “invite” e-mail from TSBC?
A:  The e-mail may take a few minutes to arrive in your Inbox, but if you don’t receive it within a reasonable time, it 
may have been blocked by your e-mail. Check your “Junk” folder in case your system does not recognise the e-mail 
ID (and mistakes it for junk). Also, add ecofees@tsbc.ca to your “safe list” so its e-mails are accepted by your system.  
If you are still having issues logging in, please contact TSBC (Monday to Friday from 8:30am – 4:30pm Pacific time) at 
1-866-759-0488.

4.  Q:  Will there be training provided for the new system?
A:  TSBC is providing this guide as a training manual for remitters, including screenshots and descriptions of the most 
common functions you will use.  Refer to the “Getting Started” section for further details on what is needed.  The User 
Guide and Quick Reference Guide are also available at:  https://tsbc.ca/participant-resources/

5.  Q:  How do I know if my ADF Return was submitted and received by TSBC?
A:  On the Summary page you can see if you have Filings to complete, or to approve and pay, or if payment receipt 
have been confirmed by TSBC.  You can click on the areas to drill down and see more details. The Closed Invoices 
tab shows all invoices which have been fully paid.
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Frequently Asked Questions (cont’d)
FAQs

6.  Q:  How do I make adjustments to my ADF Return once it has been submitted?
A:  Once an ADF Return has been approved it cannot be adjusted. However, TSBC is able to adjust a Filing (ADF 
Return) if necessary, so please contact them if you require a Filing adjustment.

7.  Q:  How do I setup TSBC as a “Payee” in my online banking system?
A:  To setup TSBC as a bank “Payee” log into your banking system and go to where you setup a new “Payee” 
(usually under “Bill Payments”).  Search on “tire”. They will be listed as “Tire Stewardship BC Association”.  
Enter your 5-digit TSBC Registration # as your Account #.

8.  Q:  What is TSBC’s banking information so I can setup payments to them by EFT?
A:  You will need to contact your bank to ensure your accounts allows EFT transactions.  Then use the following 
payment routing instructions to setup TSBC for EFT Payments:

Bank of MontrealPay:

S.W.I.F.T BIC CODE: BOFMCAM2 Bank ID Codes:

BMO Bank of Montreal 
2219 Oak Bay Avenue 
Victoria, BC    V8R 1G4 

Account with 
Institution: 

Tire Stewardship B.C. Association 
300 – 536 Broughton Street
Victoria, BC    V8W 1C6

Beneficiary 
Customer:

Transit: 27060 
Institution: 001 
Account: 8900-427

Bank Account:
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Frequently Asked Questions (cont’d)
FAQs

9.  Q:  Why are cheques no longer acceptable?
A:  TSBC is moving to an online system for the submission and remittance of ADF Returns to reduce paper handling 
and costs for both retailers and TSBC.

10.  Q:  How do I know if TSBC received my payment?
A:  When payments are received and reconciled by TSBC, the invoice will be listed under “Closed Invoices” and 
will show the date payment was received.

11.  Q:  How do I register as a new retailer using the system?
A:  Refer to the “Register New Locations” and “Self-Registration” sections of this document.  If you have an existing 
account (Registration #) with TSBC, you do NOT need to re-register.  This system uses your contact e-mail ID as 
your account User Name.

12.  Q:  How do I change which Remitters are in my “Organization”?
A:  Your Organization was setup based on information in TSBC’s existing system. If you need to change this, please 
contact TSBC (see the “Help & Other Contacts” page) 

13.  Q: How do I close my account using the system?
A:  You will need to contact TSBC to close your account, or in the event of a sale or change of ownership.

14.  Q:  Who do I contact if I have trouble accessing the system?  
A:  You can contact TSBC by: 

Phone:    1.866.759.0488 (Monday to Friday from 8:30am – 4:30pm Pacific time)

E-mail:     ecofees@tsbc.ca
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Help & Other Contacts
TSBC e-Commerce

1. In addition to this User Guide, please refer to the “Quick Reference Guide” document for a two-
page summary of the key concepts of the e-Commerce system.

2. The “User Guide” (which includes the “Self-Registration” process) and the “Quick Reference 
Guide” can be found on TSBC’s website under “Participant Resources” and clicking on either “E-
commerce User Guide” or “E-commerce Quick Reference Guide”:  https://tsbc.ca/participant-
resources/

3. If further Help is needed on how to use the system, contact TSBC, as follows:

• Questions on Filing or general system guidance, e-mail: ecofees@tsbc.ca

• Questions on Registration process or business information, e-mail: registrations@tsbc.ca

• Any other question, please call: 1.866.759.0488  (Monday to Friday from 8:30am-4:30pm Pacific 
time)

4. If you need Tire Pick-up, please contact:  1.866.497.0281
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https://tsbc.pictus.online


